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FPGA 7= it g T2 e & 77 Th e I Re M Je Thee, 584 RV FPGA 7= il Jafs
ME TS, BERMBA P Eirh A Gowin FPGA 7™ i«

1.2 B~

AT IR 5 B T I s o R FPGA 77 i

1.3 tH3X3CHH
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1 RFARFM

1.4 Rif,

rng i

1.4 RiG. 4aR&iE

R 1-1 RN AT BLRA CORE . A AT OB X

F1-1 Rig. 4EEE

ARG HERETE 2R Epd

LUT Look-up Table A&

FPGA Field Programmable Gate Array B v] G A [ 1R 51
JTAG Joint Test Action Group BeE AT 3h 4
GPIO General Purpose Input Output AN RO
SPI Serial Peripheral Interface AT MR RO
SRAM Static Random Access Memory FRSBENLA S
MSPI Master Serial Peripheral Interface FHATAMNEE D
IEEE Eﬁgit#:;f Electrical and Electronics HLA R T TR e
ID Identification S riRS

CRC Cyclic Redundancy Check PEIR TR

1.5 FRZ SRR

ez PRSI AT REEOR SR, A A IR rP QA A A 5 ) B A

AEESARBAR:
Pk www.gowinsemi.com.cn
E-mail: support@gowinsemi.com
Tel: +86 755 8262 0391
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AEEENAE

2 zmn

PR FPGA 7 it g A T B AR b I — 284438 K

& WA P AGEE S TR FPGA P i R R IC B A S M

* 2-1 LiAlfERE

2R

e 3L

#FE (Program)

¥ Gowin =R 2E ) LR BUE 5 N3 FPGA
W E Flash 58{3# 5 FPGA #HiZEK14M5 SPI Flash 1)

i & (Configure)

¥ Gowin 2z Y53 A B BRI B 38 5 A R % 1
BN E Flash I 2] FPGA ] SRAM 17ifs [X [y it

o

GowinCONFIG

FrRIEA T IJTAG BLEBASS, =Tk FPGA 7=
X FR AR E T, B ARSI E, XURBh
Bl &, MSPI it &, SSPI it &, SERIAL fid &, CPU
Bl & .. e GowinCONFIG At B #E £
DER T 2SR TS R R R

HEshAlE (AUTO
BOOT)

FPGA M\ B Flash zH ELar i Boda 17 e & i i
FEo RAAES RE M LR,

XA sl E (DUAL
BOOT)

FPGA MW E Flash 871 Flash S2HX LRt 2 s
HHATRCE AR, 2 AR SO A E N B
Flash F17M5 Flash, 24&E %R Flash Be & RG]
3% ik Flash HHATRCE . RAAES KRB C Rk
s

FPGA 1E N E 244 (master), it SPI #:00FE5hM

MSPI o E 513 Flash S H ARSI TG et
SSPI L FPGA 1E A2 (slave), #MEENL (master)
SETE SPI P2 115 A Ho e S 47 T B (3 7
FPGA 1E M54 (slave), #MEENL (master)
SERIAL FoE S E T4 115\ H O T I B 3
CPU it & FPGA 1E M E1E (slave), #MEBEHL (master)
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A

B3

IR D (RO 8-bit) 5N FLRs it Hodh it
TR E R .

ZHEE (MULTI
BOOT)

MSPI Bt B A IATAEM S, J2H8 FPGA AR
Flash (AN [k sz B b Ry R A bm 3k 47 e & i 2
FA PR RT— AN EERR i 20 5 ON 5 — IR BC & 1 LRy
WA E L, TER AR I T i ik
X RECONFIG_N P4 dmim s e i B« SCFF
MSPI Fit & 151 FPGA 72 i 15 3 FF A =X

M —mN SR, BIZE FPGA B3 TIE)E, &
BFF TR, Sl R R LR R BE 5 N3

TR 40 Flash #f, il3dfi% RECONFIG_N ok 2 %7 -
H# FPGA 2EUAMEE Flash 58 i & 1 F2
FPGA 2814 LE AT 1 77 AR ROE B R 10— F

HACEE 3, AT DU BE B $ OB R0 o) g A AT L &

A BRI BT 2 18] 4 REA% fan icdis .

P (User

FPGA 5E il —IRIC B E#AE G, B ismsFesc 4 H P
FIAT A, RS P AR B 5 B2 il H S T

Mode) .

oS FPGA 281 S 0ihn iR, B— AR50
D CODE 580 FLAT ST IS

Fi PR 8 OIS 1 FPGA 2343547 1 B Bl
USER CODE Al PLdid Gowin ek 5 N B AE A, fHm ] 32

£F 32-bit.

@4 (Security Bit)

RO R FPGA 7 il ic B 20 1 22 e PR
WRRFIR BT TP RS B 1 2 A B LU R A
GNEIE, AR NHECRE JC k34T B [ S
TR BRI FTH FPGA 7= i (1 LU ARR I A4 1
T e

i (Encryption)

GW2A(R) # 51| FPGA 7 fit SCRF IR, I i L
HEHE SN FPGA Ja, #ff BT 55 5e i) Y]
ULHC, VGHECHGE A REAT s JF i s F s DLECRIK
Ja # AT IR A
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3 ECEE M4 3.1 P B B IS S L I

3 ECEEMITE

3R FPGA P L B ZHE, BAE ML JTAG LA T3
FLE. WaiCE . RATRCEMIFATRCESE, W LU 2 A SN AR 1
HRhFE R AR B SCIE IBE R0 e L B e, AT DL E N i)
/O, F ) AT HRHE SEFn s I O AT e . Pt ml ARSI TC B A A Th REXY
HREIEH], 2 SRR K

3.1 BEEEEMYIREE RiEm

3.1.1 Be EERHIR
B 7ok Sk FPGA P i ST B S N % 3-1 Fir, £F s
VT AR A X D 0 A D A P e e R e A B R
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3 ECEE M4 3.1 P B B IS S L I

# 3-1 B ERHIR
GowinCONFIG

BN /O K74 | JTAG QBTO? sspi | mspl ggg} SERIAL | CPU
RECONFIG_N ! v v v v ! ) !
JTAGSEL_N ! v

TDO o v

T™MS | v

TCK I v

TDI | v

READY llo \ \ VoW v v v
DONE Te) \ \ v v v v v
MODE[2:0] ! \ VoW v v v
SCLK I v ! !
CLKHOLD_N/DIN | | v v !
WE_N/DOUT 0 ) !
MI/D7 /0 v !
MO/D6 /0 v !
MCS_N/D5 /0 v !
MCLK/D4 /0 Y !
FASTRD_N/D3 /0 v !
SID2 /0 v !
So/D1 /0 v !
SSPI_CS_N/DO /0 v !

V|

o N[FFS RN B SR B A AN, S TR R B R L B UE 5%
GWIN(R) Z 7 FPGA /=4 4 F2 0 B FHIGW2A(R) Z J FPGA /743 4 FE I B T
o XTAMAMEMN FEEMIE XiES% 5 M EHRANH.
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3 ECEE M4

3.1 P B B IS S L I

312 EEMER

NEKRAHSE R 110 AR, w32 H FPGA 7 SCRPRBCEE
v E 5 E 11O . BT RF11) FPGA b5 A TAT Il B ERT, 5
Fic B AR 5 B RIS B A R OV BC B8 S P o L LR i » SR RE N P AR 2K
2 HE P P e 5 1) A P 34 T B G RAV A T

Varl |
FE!

R v B B LI, 50 R IR S B AT a RS A R i 8 F O BC B AR . XT3
Wi B, AT R R AL
Pic B I A i an 2k 3-2 fhow

Sy FPGA #E M A 0R Mt AT 2ok

R 32 BB ME FHIER
BE AR BEE LI i ie
TMS, TCK, TDI, TDO 1E~N%* Ffic B &1,
NON-RECOVERY JTAGSEL_N £} GPIO.
JTAGSEL_N 1 /& HECE & -
JTAG PORT ® JTAGSEL_N=0, TMS,TCK,TDI,TDO f£
RECOVERY ATC
® JTAGSEL_N=1, TMS,TCK,TDI,TDO 7£
B & 451 5 1E N GPIO,
SCLK, CLKHOLD N, SSPI_ CS_N, SIfn
NON-RECOVERY . e - =
SSP| PORT SO ENELHFCEE .
RECOVERY SCLK, CLKHOLD_N, SSPI_CS_N, SI A
SO 7Lt & &5 K 5 1E N GPIO,
NON-RECOVERY FA?‘,TRD_N, XCLK, MCS_N, MO Fi1 Ml
MSPI PORT Y P TC A A
RECOVERY FASTRD_N, MCLK, MCS_N, MO #1 Ml
ERCE 45 W5 1E A GPIO.
NON-RECOVERY | & FIBCE & .
RECONFIG N
- RECOVERY it & &5 R 5 1E N GPIO.
NON-RECOVERY | LHEE %M.
READY
RECOVERY Be & 45K 51N GPIO.
BONE NON-RECOVERY | LHIECBE M.
RECOVERY BC & 45K 517N GPIO.
¥

e [1]4F JTAGSEL_N A& HRMEA:, HAERR ITAG & HEH RN, il
AT MODE it B ~3E A s B At (RIAEE B3 BURSIA MSPI #5838 8
Go oAt CAF IR B S L B AL AR, P B S Fahidt AT ITAG BB 5, 2e1FHE AT
X, JTAG & AN GPIO;

e [2]SERIAL A1 CPU Mt B A0 I i T 5 HAbBC B0, Bk st BN GPIO,
{2 240 S A B A AE R L ic B A S AT B E N GPIO.
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3 ECEE M4

3.2 e B & I Th g M N

it Gowin IR ALEEHE M-
1. FTHF Gowin Z I EAEHAH R T2
2. TESREF:FEFE “Project>Configuration>Dual-Purpose Pin”, #n& 3-1

I

3. ALK NG IR LG B BN R O

o 31 BRI R

Wy Configuration

P x )

| Synthesis I Flace & Route Imal-Furpose Fin | BitStream |

Download Mode: |JTAG

d

Use JTAG as regular IO
Use SSPI as regular I0
Use MSPT as regular IO
Usze EEADY a=z regular IO
Uze DONE a= regular IO
Use BECONFIG M as regular IO

0K ] [ Cancel ] [ Apply

3.2 Bl EEMITRE R L A

RECONFIG_N. READY #1 DONE %& il /& &3 Fiiss 20 284 F 3 (&
At P B A R AT R e LA N % AT B R ER P

UG290-1.03

R 3-3 EHINEE

B4 TR REH R
VERNECE N, 8808 N, BANEEs .
RHESPHERL, 24T FPGA SFEIE (8 M Thas,
RECONFIG_N H&B} FPGA ToiEHEATART 77 2RI
fic B 1R

RECONFIG_N VENEC B R, T ANk 58 AT 25ns

(RIS F5 5 GowinCONFIG FR B, [ #e 4%
H8 MODE & B {H B8 gk L Rr i g . - tmg A
W g P L, MR E B R Ak
FAEHEAT HETC /BN GPIO B, REEAE output
KA, N REEEE SRR T, P EH
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3 ECEE M4

3.2 FEE IThaE XM
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B AR

Thae g

RECONFIG_N ‘& IS 754 ) s E & o E

READY

inout 2R E I, SHFAER, HA READY HiEHt
FPGA 7 Rei#k47TC B #:1F , READY 15 5 HiK )5 75 K
P34 F ekt )k RECONFIG N ()75 2k &2 4R
==

VE T B & I, 254 output 257, 0] LT/~ FPGA
MATRE BT E . U H AT E R

READY {55 s HF; HEE KM, Ul READY 15
SAS AR 254 input 288, P AEE A &2
S BT B AN N AR READY 155 DAZEIR it B
2. fE GPIO I}, AJRI{E input 5% output 282!,
READY H{E input 8& ) GPIO B 78 fRIEEC B 46
RIEAYIHEN 1, BN FPGA LiE#HTHRE .

DONE

inout KA. FPGA FLE IhMtrEfES, HE
A3 J5 DONE 1554 & .

VB BC B & B, #54 output 287, AT LLFE/R FPGA
MRTHCE SRR S T MG E ), DONE 15
SONEHT, SN TARIR: M E AR 5
B E RET, DONE {5 S RFHEHPIRES . HN
input 2844, P rldE T 3 5@ EE SRR AN
$i 1t DONE {55 DASEIR gk A\ FH =
RECONFIG_N i READY {fFHK B PR AT,
DONE & S & RN TRE . T JTAG H
L H SRAM it #2H, DONE 5 5 HIMEHK A S %
B X fE5 GPIO I8, WTHI{E input B¢ output 2524 .
DONE FE input 28 GPIO i B UERC B 44
MIEVIEERN 1, BNERESKRE FPGA TLiE#EA
PR

MODE

TENBLE R, RACHmIN, W L, &2
Al % 3-bit f7 5% , GowinCONFIG At B k15 5 .
FPGA _I- BRI HE - ik i %2 RECONFIG_N i,
A4 MODE {E it A FH M) GowinCONFIG IR
&, mn SR EA RV FPGA 77/ MODE {E X}
. C B A RS A AN, BT 275 M B A A 1
FRRCE FM. BT AR E I E A E,
BB MODE &I AR e A H e ik, REHEH
K1) MODE /& JHITE #8144 & O e th, BAKTE =540
N #2441 PINOUT F-/it . MODE % i v GPIO I,
Al FAE input B output 287,

JTAGSEL_N

TENECE S R, BB, WS bd. i
PGB T ITAG & HE N GPIO, |42
b HE AT — ORI BC B S JTAG & AR N
GPIO, JTAG ELEDhaekak, H @i ik
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3 ECEE M4

3.2 FEE IThaE XM
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B AR

Thae g

JTAGSEL_N #ATME; WHRH A A %E ITAG &
[, W ITAG BLEDiRe—HE T H. 1EA4 GPIO
i, A AR input B¢ output 257,

!

JTAGSEL_N &5 JTAG fic & 1) 4 N (TCK. TMS.
TDI. TDO) W E N GPIO W f#/E H /7 K FH: JTAGSEL_N
WEN GPIO I, JTAG B R G/EAMEEH; JTAG &
¥ BN GPIO B, JTAGSEL_N R AEEVE N E &

TCK

TENBCEE TN, RADYMmA .
JTAG FLE B A B AT B NE . /N GPIO
i, B AE input B¢ output 257,

T™MS

TERECEE W, RACNRIAN, WSS Ehi.
JTAG B ERA R B ATIR M A E . 1E8 GPIO
i, A HAE input B output 2871,

TDI

TENECE B R, KEONIN, W5 Edi.
JTAG Bt B AR R ATEARM A E . {F25 GPIO
i, ®]FAE input 2% output 257,

TDO

TENBCEE I, KA % .
JTAG Ml E B AR AT B M E M. /£ GPIO
i, A HAE input B output 2871,

SCLK

VRN B IR, SRINEIN .
SSPI. SERIAL F1 CPU g & 5 = i) Bl S N8 D
YE24 GPIO K, B FE input B¢ output 257,

CLKHOLD_N

ENTCE S R, AN, W35S L.

SSPI #1 CPU FC B BN 28 UE & : MmN S
HE PR, SCLK X MR 288G A NI,
SCLK X B #E To R 4F 8 GPIO I, 7T HAE input

o output 57,

SSPI_CS_N

TENECEE T, KA, WSS B4, SSPI
BeE B U RIS S, IKEFAE R 14 GPIO I,
A] F/E input B output 257,

Sl

TEBC B S, SRR . SSPI BC B AR 8
ITHARMNE M. 1E4 GPIO I, # H{E input 5%

output &7,

SO

TERBLEE N, KA N . SSPI I BRI &
T8RS A . /A GPIO I, AT HI{E input 2%
output 287,

MCLK

TENTCEE N, KRN

MSPI Bt & A ) d ISR, SRIET FPGA Y
R em R, AR I AR YE R 2.5MHZz~125MHz,
RS A Z Ky 2.5MHz, MSPI B & R A8 S0k
125MHz W8k T A N 3R B FE R 76 2 25 4
I 2 A R 0

F P ald@ i = PR S S AE 2 MCLK 3R AE,
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3 ECEE M4

3.2 FEE IThaE XM

B AR

Thae g

Kl 3-2 os: T A TR, FESe s hid
“Project>Configuration”, #.i5 “BitStream” 1145,
7t “Download Speed” TFHi5l# F1i&#E MCLK [

SR . {8 GPIO K, AT H4E input B output 28
A,

MCS_N

TERNECE BT, KA .
MSPI it B 5 X8 k5 5, KA 24 4F 8 GPIO
i, B AR input B¢ output 287,

Ml

TENBCEE I, KA.
MSPI Bt BB AR R ATEIERAE R . /E4 GPIO
i, B AR input B¢ output 257,

MO

TENECE BN, KA .
MSPI it & B ) # AT B g . 124 GPIO
i, ®]FAE input 2% output 257,

FASTRD_N

TENTCE S N, KRN

MSPI Fit B0 EC SPI Flash #FiEFES: X
FASTRD_N A& HL P i 3 @ s B =0 (454
0x03); 24 FASTRD_ N i H P i kg i i s B =,
FAT KM Flash il UEEE AR, AR
SN Flash FI%3EF M. 14 GPIO i, AT

E input 5% output 287,

WE_N

TERBCEE N, RACAHA .

CPU Mt BB A S REfE S I B W: 4 WE_N
N AP RN EERAE s 2 WE_N PR R 0R
E5¥AE. E4 GPIO I5f, ATHI{E input 8¢ output 28

A,

DO~D7

inout AL T

CPU i B AR A B EHa 5 N i tH 7B, 8-bit 798 . R
5 WE_N [{E#fE DO~D7 s s 1a. 1EN
GPIO i, ®]H{E input B¢ output 287,

DIN

VRN &S R, AN, WEES L.
SERIAL Bt & B AT 5 da i NS 1 1E 4 GPIO
i, AT HAE input B output 287,

DOUT

TERECEE N, KA.

SERIAL P B #8520 B AT Hotfa e 8 B, AAE FPGA
PRI FAE G — et ri . 18 GPIO i), #f
FAE input 2% output 287,

UG290-1.03
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3 e & & A4 3.2 e B & I Th g M N

/& 3-2 MCLK iR % &
- s Configuration m

| Syntheszis I Place & Route Dual-Furpoese Fin BitStream |

Ensble CRC Check
D Enable Compress
|:| Enable Encryption

Key U‘[e}{) o lanoonoooo-=-000000a0-00000000-000a0000

Enable Security EBit

Download Speed (MHz): [250/100 (default) ¥ |

250,30 -
SPI Flash Address: 25032

250,34

USERCODE : 250436

25035

250,/40

250742

250,44

250,46

ZE0/100 (defanlt)

| K ][ e ][ Apply

UG290-1.03 12(34)




4 R ST 4.1 PO B B

L cssmsen

iz P AR Oy DRI C B O ) 2 e HER R4, A2 FPGA 77 i B LRI ST
PERERAINA T CRC BB SHVAIF W E 1 L. Bl id B A Se R e
NBE RS A, BRI M BE A F, DONE {5 53k, WHE 1%
AL PRI AR SE B EL R, AR P VA AT Rl A

4.1 BCEHEME

5K GW2A(R) & 51 FPGA 72 i S R LL R BT I, KA
128-bit [ AES Jin % 515 . I P E Gowin z J5 A S i i N N3 4 (KEY),
B 2 AR s P B B AR RN S B LR e, I I LR IR O A 2 2
Ji, FPGA 2R 35 e fr NI 255 2 S AE 04T e B HGR i Al, e bi T /5 5%
R E SRR, AT RMUS READY A1 DONE {5 5 RifK, S JCikiEw Tk
FE IR HA B NI B H R TR T
1. AT RS TR A B ) A%
2. TEEHFIFIEFE “Project>Configuration”;
3. Hii“BitStream” 125, 2) 1% “Enable Encryption(only support GW2A)”
HAmANEYME, ik 4-1 Fos.

UG290-1.03 13(34)




4 LR S 4.1 Fie B 33 n %

B 4-1 & FHAWRETE
rw Configuration “—l—'@ X

| Synthesis I Flace & Route I Dual-Furpoze Fin BitStream |

Ensble CEC Check
|:| Enable Compress
Enable Encryptionfonly support GHEA)

Key (Hex): 00000000-00000000-00000000-00000000
Enable Security Bit

Download Speed MHz): (2507100 (default)

SFI Flash hddress: FFFFFFFF

ISERCODE Q0o0aa0a

I P E I 5, 3 7 B R 1 5N B FPGA M P17 i X,
A BEARAT N (0 EO R T s 5 U
il I S NTHEIR .

1. 77T Gowin % FE 4 A

2. A% FPGA #s

3. AR AERE Configure Security;

4. (BB EN TN 0% A I R write " H 5 N B FPGA,
e 4-2 fioR .

Bl 4-2 il E T E

rw Security Configuration l 2 ﬂh,r

write ] [ read ] [ lock

Lock ! Rafuze for writing and reading -
Read ! Display the key (when unlock) (o
Write : Frogram the key to FPGA -

UG290-1.03 14(34)




4 LR S 4.1 Fie B 33 n %

fife 2 2 B 5 ON DD JE ] DL B T sz AR A Bl 52 5 N B AT I
UE B 5 NN )5, P el 4 lock v &K 3540 “BiAL” 76 FPGA N,
AR A S DO 5 N E# R B E AT B0, s
A AN “17. WERREHE, INERRnidE RE 505 %
FAVCEC R Jo A Be el . AR N LeRrim 2 s i IC B AN 2 25 5A 52
!
a3 FPGA VIR ERTE AL 4508 0, Uit E A M — MBS0 1 Gkl
5] Q. 4541, FH P ) 5 YRR A Hh 'S5 ON 1K %6 4714/ > 00000000-00000000-00000000-00000001 ,
ZJE B B AR R B I B AR A A A2 1
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4 R ST 4.2 TR B ST KA

4.2 BER BRI

m TR FPGA 7= i B AR B a0 e ik fikg X, = A4
B fE 284408 fs BSCE =2 SCAMS S, P AT DS w2 3k Ak o 1 3 4 T B
HHEAL N — kA%
1. TJT Gowin 4mFLitt,
2. BdiSEHAY “Tools>File Converter” #1770 T A,
3. XhAHK “File” EF 7R B U IR B RAF B8R, A N A
“Convert” {83474, K 4-3 Fros.

N
B 4-3 LR A F B TR
W File Converter =R X |
Conwvert to: [BIN V]
Save file as: Difsoftware/Gewin/l.7.2.01/1. bin (|
File Size(bytes) Device Checksum SPI Address
1 Difsoftware/Gowin/1.7.2.01 /warkftest_pllfi... 577160 GW2A-18/... 0xCOFD 0xFFFFFFFF

o SRR LRI AR R SE, B 4E e 5 A P B A e, AR
B4 R PR R 48 I C & SO R/, iR 4-1 B
% 41 B =54k FPGA 7= AR Bk

arfE AR MBS RN (AE EBR) P B SR/ (F EBRD
GWI1N-1 42 KBytes 82 KBytes

GWI1N-4 142 KBytes 216 KBytes

GWI1NR-4 142 KBytes 216 KBytes

GW2AR-18 563 KBytes 886 KBytes

GW2A-55 1393 Kbytes 2268 KBytes

!

o [AJHAh i Y E B SO RN SR BERRAS T 5
o [21RTIHE R BRI ST RN, F B E SO R BEAT R 4 -

UG290-1.03 16(34)




4 R ST 4.3 BLE LI E

4.3 LB XTI E

& TR FPGA P2 i Jw R B OQ R VE 75 B 45 IR i A T 1 T
T B DAAE RRIE A 04 AR 0

WO LA FENC B R A A S 13 TR BU AR 7T 5CHE A BSORH S R e T

it & & S AW E T iEES % 312 B EHER.

e & B A S W B R iE S % 4-1, ETIEHE CRC /IR, Lhks
WMEYE AR IEEHKE. ZeMNE. MSPIBLEMZR LR, LHAE
#i30 K SPI Flash Gzl #% & . USER CODE # &%:. SPI Flash J& 5
HHAR 12 A TERk, P T E /2 ADDR[23:12] 1 Hutik 25 (1]

VE

22 AR 2 BT ) 1 5 5 1 B S L R ) 20 10 22 A U RO, P R L
R EATRCE , R DURIE SR R 22 4, SCRENE B LE A T [ e 0, BRRR T
AR T P ORI 2 A

UG290-1.03 17(34)




5 Fo B AN 4 4.3 BLE LI E

5 L ERNTE

oS4k FPGA P2 i & 36T SRAM L E ) GW2A(R) & 41 () = P B
e AR Flash (1) GWAIN(R/S) &7 /NE &R Rkt . HET SRAM T
SIS A AR N E SR Rk, R EHERENRE; A
Flash H3E 5 5 284458 H Ja 2R A AR A7l 7005 7 N5, B3 b FLR v DLk
H Ja e & BNUE shlc B 177 N S H sh g T il E .

mat TR FPGA = 3R E, —FE 2 SRR B AL
X EHREH RN E S W E AR raE SR CRREHMN ITAG iE; R
FIEZ KB H B shE S shlic B ; FF L BB MODE B %5 A [H .
!
KT GWIN(R) R & GW2A(R) & %1 FPGA 77 i SRR AC B AR 3 K B B ERIE ) 3 5%

(GWIN(R) %7/ FPGA /=aa i AL & FH ) Fe (GW2A(R) 7Y FPGA /=it 45 FEAL & F M)

3 YRR E AU

UG290-1.03 18(34)




5 Fo B AN 4 5.1 i B AU

5.1 BCE

TSR FPGA 770 H T 20 8 GWIN(R/S)FI GW2A(R) P K5 ik, He
i GWIN(R/S) K jifd & GWIN-1. GWINS-2. GWIN(R)-4. GWIN(R)-6
A GWIN(R)-9 #5177 . GW2AR) XK E ALY GW2A(R)-18 1 GW2A-55
MRV AR PEAEES R AW ERE, FEXHZHW R ) FPGA
NEEERL T SDRAM. 2 A HEE S 1 FPGA [ 7 AUS ShEC B 5
GWI1N RFnEAH Z=57 2 4b, HAhFrE 2 M, 56T 00U Shic & 1 HEgNE B,
E5% 5.6 Wa L E.

ma SR FPGA 7= i HE L B 0 00 47 1 A 4a 2 194 E A B 7 ot
SRAM f#fE. XN & Flash FIERVERINT 4N Flash FI(E, Hd, WA E
Flash 1J#4E R GWIN(R/S) &2 %17~ i 3 HF, X SRAM FIAMES Flash ()4
YERTE P2 a8 ] S FE .

St SRAM I #A/E B 4% 3 B #544 ID CODE #il USER CODE, #zHUZs {4k
SHEABRERLLL SRAM L E . #3145 ID I F 2l B B Er R, JfA ID 5
WE R 28 A ReHE4T L E s USER CODE #& A5 {# /% ID CODE #8 7
[ Z AN CAX 2 AT 0w S An 1 28 FIRES FAESL 58 FPGA il &
BIERPIRSE S, H PRI 8RS, IRESTFAHRNE ESH
(Gowin Programmer /4 /775 % ). SRAM B HAEN FE &, HAERK
B2 AN LR B SRR Th R . W E T 2N MBI H P e ikt
47 B LRIE

XN E Flash AR R AN ga A DL AHERR  Jm R A E IR
Heei@t JTAG #:#E N B Flash, W40 #Z R HI7E 2MHz~2.5MHz.

Y

i F 4 B Flash it E SRAM [IEAE (EBZIACEAMXUAZIEE) N E Flash Mg
HFEH FPGA T Z LR FF EHUIRAS I H AR Pk RECONFIG_N, 530 AT g2 %) N &
Flash i& A& & B .

N & Flash fIZRfEI0IE/ERL B SRAM #/EZ Bise ik, MBS R RE T
A B R TG RS g IR

YT Flash MR GG RR . dnfe DA IR AN gmAE . SME6 Flash #:4E
HIN2H MODE fH X B N “011” JARA I K P ki % RECONFIG_N
BUH T FPGA B . BRI Ry Flash, (fHZ EREH P
BHNZA HRFR AR 75 BIE A & BRI R AE -

P A A R EA SN, 7R ZEARR AL E B W/ER, itk FPGA T
EECEFENEER T . H P umeE B8 E A En, 77 BUsE e A 377
RIGALBRIX L I, RO BR AL i AH S E JIRD AT . MODE[2:01H Rk #¢
GowWinCONFIG M4mAERC BB, P A TR Z S T LA A _E 4 sl R
Fr 177 2 FLE e AR e i, b HH A 47K, R R BHAETE 1K,
!

RECONFIG_N. READY #I DONE & 5 &M EHAMC, TRHAP 2K el RERN
GPIO, #7F Z(RIF 75 T B 4 11 52 AT T A1) (0 4 1 505 J 6 P R A 5 2 S R 2%

FIP AT Bt SR B RTINS In A 5-1 Bl
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5 FE B AANH 5.1 it & 24

&l 5-1 [E %2 B MR A

DC3.3V ] MODE[0]
I MODE[1]
| MODE[2]

FPGA

||}—o/ RECONFIG_N
KEY

READY | DONE
DC3.3V 4.7K > DC3.av

N/ \V4
LED LED

o JH)UREE LA MODE fHIN AIMEINIRAGTT 5%, #70 &4F MODE BRI e Ak e ik, R
BHAEMK) MODE & Al LA B3

e JTAG L& it f#+ READY FI DONE 15 5 B A S5 8 s
e RECONFIG_N. READY F DONE A3 2% i ()4 JH L B A 2, A sz e e B Thig

UG290-1.03 20(34)




5 Fo B AN 4

5.2JTAG it &

MODE[2:0]#{E 5 Fic B AL 16T B ¢ R WIER 5-1 Fias .

# 5-1 EL BARH B2 MODE &

Pic B A= GWIN(R/S) | GW2A(R)

JTAG XXX XXX
AUTO
00T | 000 XXX
SSPI 001 001

GowinCONFIG I\DASKII_ 010 000
BOOT 100/110 XXX
SERIAL | 101 101
CPU 111 111

¥E !

e JTAG it B 5 MODE i .55, GW2A(R) £ 4| A ¥ # AUTO BOOT #1 DUAL BOOT.
GWI1N(R) &5 ML ) DUAL BOOT, GWIN(R) &R FIFTH FPGA /= i35 3 #F
MODE {Ey 100 [#) DUAL BOOT #&x(, {Hs& A GWIN(R)-6 fl GWIN(R)-9 #ffX
FF MODE 1/ 110 ) DUAL BOOT #%3;

e GWINS #%I FPGA 7= Witk 2 A Flash Hith, 1% Flash 7714 FPGA ] bitstream, 2™
Flash J8 & 115 0L R A7 il MCU IR SO sl ke R AR, (H 8 173 2 P BIRER =7
3k, 2" Flash t7] LL#7fi% FPGA [f) bitstream, HAHMEN T, 2™ Flash A~ gE17 % MCU
B SRR s, P T kAN Flash 77245 %0 . GWANS Wik 2 4 Flash

PR 7 1

52 JTAG EE

UG290-1.03

Varll |
FE!

Hie

#4i% 1/ bitstream 304

KT ITAG FECE I 7 B KA P 25 15 735 225 (GWIN(R) R 51 FPGA 7 il i e i
BFM) K (GW2A(R)R% FPGA /=i ZmfEiC & M) 5 Bl E R4,
E ok 5R FPGA P25 JTAG It B4 T4 IEEE1532 ArdEAn
IEEE1149.1 i1 S H bR
JTAG Bo B AW LR AR 5 A 25 =2 58 FPGA 7= i ) SRAM
, FHHEGBERERE L L. S SHRTAEER FPGA 7 M35 FE JTAG
LB, JTAG B E B X AIAH S IR 5-2 Fios.

K 5-2 JTAG BB e X

(=g B /0 7Y Tt B

JTAGSEL_N L g %ZTAG EHM GPIO K& N E &, (K-
TCK? | JTAG HATHH BN

TMS? |, B 55 4 JTAG HATR A

TDI WA IS EH A JTAG HATEHERIAN

TDO o} JTAG 4750 5

!

e [1]JTAGSEL_N {55 R A Y JTAG &I B N GPIO H HAs4F 8 3 TAE 5 A4 ek
e [2] TCK #fE PCB Li%E#: 4.7K Tz AifH.
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5 FE B AANH 5.2JTAG it &

JTAG It B B A E B o0 R UK 5-2 Fiw.
B 5-2 JTAG Ee BEAZEBE B E

FPGA

__ I JTAGSEL N

JTAG PORT » TDI

» TCK

» TMS

A

TDO

ALY

o  XIT JTAGSEL_N A Hk#4E, H P ITAG BHE - E G, il -
HURTH MODE i ¥ B A aE A ShIC B B (B A3 XSUSSHAT MSPD 38 4 3 fth LU
FHURIEE LR, P RS TEET ITAG B S, BN PR, JTAG
E AN GPIO;

o JTAG M & 1 U B AR AN e =y T 40MHz.

B 7T HE AR ITAG BCE SRAM #:1E4h, mo - SR IE S % FPGA 2%
f (GWIN(R/S)Z%1) I & Flash FlLAh A R 511 FPGA 7= 5 1 7M5H
SPI Flash FI4mfE /et B JTAG & T . A6 5 K 2814 N B Flash 119w
FEEAEIEL 7 G ITAG BB AHE, ~M56 SPI Flash FIgmfeisfEiE =%
K 5-7,

AL, B2 Sk FPGA 72 5 S0 JTAG e ER/E, |, #8— FPGA
ff) TDO & JIi%E#R:3] N — FPGA [ TDI &1, Gowin ZwfEix -2 EH 5hiH )
ERAE L) FPGA 33, IKIRHATIC B - 25 L BE R B i s 2R W 5-3
Fr7s o
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5 FE B AANH 5.3 HJA sl E
A 5-3 bR B EE R R
JTAG PORT FPGA FPGA FPGA
TCK » TCK » TCK » TCK
TMS »| TMS » TMS » TMS
TDO » TDI TDI TDI
TDI |« TDO TDO

TDO —‘

5.3 BBz E

UG290-1.03

Y
ST FCE AR AR G RS B 4 5 5% (GWIN(R) 241 FPGA 7= i FE T
BFM) K& (GW2A(R) &% FPGA 7= ZmfE il & F M) 5 Bl E B4,

HE Al B, Bl AUTO BOOT Bt B, &&=k SAkerxt
GWIN(R/S) ZF1HE 55 2 FPGA 77 i (1) 5 i) H2 0 R 1 9 1 — Fh e B AR,
GW2A(R) %% FPGA F= A FFH R E R . BRIMEAT, Ok
WG C R ERZ/NT A E 0, FPGA BT 547 M B Flash 2H L RFmR B
SE R E -

A B R iU, B iR EEit ITAG £z U I & 04 dn F2 2
FPGA [JN & Flash # (&% JTAG L B UEH R E K, K 5-2), REH
7 MODE {f°4 “0007, 4 ZR%EHT I B K H - fikd s & RECONFIG_N
BRI, SO 2 B 3 LU R e AL B S A . P K MODE ([EIRE N

“000”, f#iH Gowin ZufE w2 B Flash 453 J5 FPGA & H AL E
SRAM SEH JE 8. N B Flash (15 i 28 85 9 e B FE T 20 7 N3k,
Pem T TAERR

T GWIN(R) 41 i HoAth FPGA 725 L E RAE S — ik E B Shi
BH#AE, GWIN(R)-6. GWIN(R)-9 Il GWINS %71 FPGA L Eilk ik H
BEECE, BRI, LHEEESIECE RN, #3407 b E st 47 i R E T B
BE. SR B M R 2R A FE 1D IRAEHE 1R, CRC RIGH R FFE LS4 1%
V!

W E Flash 1 L AECRAE— 0 LLBR R, OB R Wi TR .
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5 Fo B AN 4

5.4SSPI fit & A2

5.4 SSPI Bt EE =

UG290-1.03

VEI
KT SSPI BLE W7 B KA 7S5 1 70 3 2% _(GWIN(R) £ 7 FPGA /=i i F2 A7
BFM) Fi (GW2A(R) FF FPGA /i i FEf B F L) 5 J B A2,

SSPI (Slave SPD Bl &R, Bl FPGA {E M 284E, B4 Host it
SPI £ 0%z - 4k FPGA 7= it AT e B it A2 . SSPI B XA S AL &
BN 5-3 Fiow.

% 5-3 SSPI Bt BB
B4R 110 28 i i
T HL e R LY FPGA #H T 4mfEd &
READY o (CHT: A 1E% FPGA HEAT 4 &
DONE /O T RIS R R
MCHL T R 58 g AR AC B kg P i B 2T
MODE(2:0] L’g%@g gy | RCEBGULE READY LIHARRE
SCLK | PN
l, LT SCLK XM SPI #RE A %L
CLKHOLD_N MBS R | (T SCLK XM SPIERFETE AL
SO o) FPGA % %% 1 Host
Sl | Host 7] FPGA i A\ ¥
I, M 22 7 ol
SSPI_CS_N B8 | h SSPI jikf5 5, KM A
# H] SSPI Bt & A5 20 & =2 54k FPGA 7= 5hlic B iR = B E
5'4 ﬁﬁﬂ_‘—\‘o
& 5-4 SSPI At B N EE AR E
Host FPGA
CLK » SCLK
DIN |« SO
DOUT » S|
CTRL » CLK_HOLDN
CS N » SSPI_ CS N
!

N SSPI R BB/ N R4, SSPI#20 MODE {8 “001” , oAt [ w2 & I ) %
HEiEZHKE 5-1.

SSPI BB & IR 7 375 M1 SRAM BB #/E4N, BAT4wFE FPGA 4k
[ SPI Flash, #@f% Flash #:{E ¥ MODE &5 SSPI Bt & #: = ) MODE 14
FHE, PR LATE Gowin ZRAEER A ik PR BL B 2 UE 5 N\ SRAM B/
Flash. SSPI 3 [1Z4aFEAM5 Flash %3~ = E & 5-5 s .
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5.5MSPI fit B 1 =

& 5-5 SSPI w24 Flash EERE B

Host FPGA
CTRL » CLKHOLD_N Flash
CLK » SCLK MCLK » CLK
CS_N » SSPI_CS_N MCS_N » CS_N
DOUT » Sl Ml [« DOUT
DIN [ SO MO » DIN

YE!
H A1 GW1N(R)-6 il GWIN(R)-9 #31f7 ¥ SSPI 4mfE 4 Flash.

5.5 MSPI fir Ei&E=

UG290-1.03

E!
KT MSPI FCE I Fr B S ARG e ZH 5 70 3 2% (GWIN(R) & 41 FPGA 7 il 4 FE L
BFM) K (GW2A(R)R% FPGA /=i ZmfEiC & M) 5 Bl E R4,
MSPI (Master SPI) BLEM#, Bl FPGA {EAELMF, il SPI#10
F 5 AN Flash 1525 G RF I 200 58 L & 1t 72 . MSPI L B i #4 :
1. ¥ MODE % ¥ B 9ZmAEsM 5 Flash dR7S, ¥ FPGA 3 I H sl i P
fik it %2 RECONFIG N, @it JTAG 2 [ B X 2w FE 2445 Flash
a
2. ¥ MODE &% B N MSPIRES, KHF ket fili &k RECONFIG_N ¢#%
B EHL, 23 E AT AN Flash 2B LA R EE,  Se kil Bt AR
R4 MSPI R B R, H P AT LLUSEHLEEAR T K 2 FPGA E3)
TAE)E, #HAFgFER, HP ol DO R B AR 2 5 N\ FPGA #ME) Flash
s, 2 BT S i % RECONFIG_ N BREEHT | AE R 485 T+ 2K .
!
MSPI it & 45 20 7 75 2% B AP MODE i (4mFE414 Flash A1 Flash 250>, P
AT I3 P B 7 T B MODE B VI DBl MODE fE AR 7 (B D) e, o mr [ 52 4
MSPI 530, {3 A0 SR g F2 430 Flash, Bk 71524 7 LR FTHIRIE.
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5.5MSPI fit B 1 =

UG290-1.03

MSPI A5 XA < OB B & 2 5-4 Fiow.

% 5-4 MSPI IR BRI &R 2 X
HHAR /O KA i
RECONFIG_N Ip’q s Ly | (GBI J23) GowinCONFIG BEE
S AT DA S T AR B
READY o (GHIT: A5 1E R Sk AT PR
DONE e E P T SE R R R B
MRHL T R 58 A FE AT B B 2 A 0 B 2 TR
MODE[2:0] 'V’\] wgg |4 | MODE %155, READY LIHRAE
MCLK o) FPGA it i
MCS N o FiEES, KA
MO ) FPGA #ii i ##i 3) Slave
MI | Slave Hii N 2] FPGA
READY 155 LA-# KA
FASTRD_N | e P2 i Flash 15 A= CRH Flash 32454 0x03)
R H P =3 Flash 15 1045530 CE A Flash 52464 0x0B)
!

MSPI AL B B A $h A G KT 80MHz, 4 8422 K T 30MHz i 75 2448 H Flash 1
ST I Bl FASTRD_N &7 . B8R4 AN 5 T 30MHz Bf, FASTRD_N i &

ZERIT] .
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5 BB R/ 4

5.5MSPI fit B 1 =

UG290-1.03

1§ F MSPI Bt & #2065 =2 S48 FPGA 7= i3k 7 e B &~ = -
K] 5-6 AT~
& 5-6 MSPI it B R EZE SR

FPGA SPI Flash

—— > FASTRD_N

MCLK » CLK

MCS_N » CS_N

Ml <€ DOUT

MO DIN

e
ULy MSPI L B AR i i/ R 48 K], MSPI  MODE {6 GWIN(R) A “010” , GW2A(R)
N “0007 , HoAth[E & IRIEEE 2% K 5-1. MSPI BC B AR = T 30MHz i
FAST_RD & JHim] &7,

I ITAG H2 ML B B dm A2 2 408 Flash #3440 %8 = B Wil
5-7 Fizn, @it JTAG N 4RfE4h i Flash 752 % B 552 ) MODE 18, 5%
Z A Pl B T . 8 SSPI 2 4w 240 Flash fZER = K
HZ% Kl 5-5.
& 5-7 JTAG ¥ O4mfE/ME Flash MR EE

FPGA

Flash

» TDI MCLK » CLK

» TCK MCS_N » CS_N

JTAG PORT

» TMS Ml [€ DOUT

A
Y

TDO MO DIN

ALY

E
BEIE ITAG #: M gm s Flash 1) /N R4t 18, MODE fH¥E N “011” (iU ff##iE
ZmAESM I Flash A 550 MODE 18D,  JAb[E & & #4152 % K 5-1.

B R FPGA P2 il H b2 5 RS — I E 31 MSPI B & 454,
GW1N(R)-6 il GW1IN(R)-9. GW2A(R)-18 fil GW1INS %41 57 I J7 T #F
1T 7858403 GW2A(R)-18 &% FPGA Y E il — AL B #1E;
GWI1N(R)-6. GWI1N(R)-9 il GW1INS %% FPGA 37 F f i I BL B 1E
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5.6 XUn shfic &

L MSPIFCE R, A nT DAz IS R Bk B ahdi AT ST
BiE. SECE RMIHRZAFR ID KBUEs 1%, CRC KRR S5 1%
FH P A] LLEE s B R C B R /E 1Y SPI Flash Hulik, 383 Gowin = iR#E M5 S
Ao X R RKFER T ECE R MO XS, AP Rt 1 8 s i mT g
N
ZEREH (MULTI BOOT) & MSPI Bt B MATAEM S, &5 FPGA
MRl — Fr 4038 Flash BAS R b SE B bR 2 b i B i #2. B b
Programmer 3 {4 SRR E AR I L T % 2 4 LRI B0 A U w2 21 7151
Flash H, #lagmEthtloh 0. F P AERT — N EeRrmEdE 5 N 5 — IR BL B 1
FCRFAL B B g bk, 7E S AT B B 15 O a8t s %k RECONFIG_N 1]
P BHEIR e A E . S MSPI E B #2011 FPGA 72 i3 S b =
!
o [1|ZHEAE T EANEBEIEN Ttk RECONFIG_N #HTHC & BRI, #/FHH
JE R E g E
o [RIHFEHZ EEE R HEL LR EIR RN, RS shH R AR ST — AN Ry
T I
e [3]SPI Flash jEathkIC 12 F2762%, FH P W& E 1) /2 ADDR[23:12]f) Huhik- 7% []
BT BRI — A Flash Bid & — A FPGA BT, 5= 3 SR 1) FPGA
P S B — F Flash BC 8 £ Fr FPGA 15 6L: 5 SPI Flash B ZAHE K
FPGA #3F R H MSPI FL B, Hith FPGA X SSPI o SERIAL Fit & 1
o BARERIET REERASHATEY . E4REEWE 5-8 s,
!
Wie B 184 1 75 ZORAH 2% FPGA 1) MODE {E 4%y MSPI Al SERIAL At B 1 s /2 MSPI
A SSPI LB &= R FPGA 7= i M A S R 2 Jr Flash L& [7]— i+ FPGA 15
o
&l 5-8 — ) Flash FCE£ K FPGA BT E

TBD

5.6 B BHECE

UG290-1.03

X S B A, Bl DUAL BOOT Fit & %X, /& =¥ Sk GWIN(R/S)
ZHAE S K FPGA P2 SR — i B . WS s EAR AN, FPGA H
FikFEMN AN E Flash 538 458 Flash i352BL ELRFRAE 52 C B . XUR ShACE
BT EE PR E Y MODE 15, MWE Flash B3 LaishaiEse, MAMT
Flash B shffiE 277 %5 MSPI BB B XA IF], 2% 1K 5-6. XUE 3IC B AR
AR T AL E AR, F P nT LR IR B 7 SR R B RO A7
A=

GWI1N(R) £ %1 FPGA SCHEFI A 5 XS shlc B AR

e GWIN-1, GWIN(R)-6 1 GW1N(R)-9 #f4+ MODE {&y “100” i, 1
Jeik N B Flash J5 3, 244 B Flash it & W , 3443 BL S8 Flash
R AT

o YNE Flash N7, FEASATEERAE. Rtz 4, GWIN(R)-6 1
GWI1N(R)-9 #5437 MODE 158 “110” i, 2%H40 ik M ohER
Flash JE3l, 2478 Flash BC & RN, 2548 A& RS2 A B Flash 951
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5.6 XUn shfic &

UG290-1.03

AT E
o YN Flash NZSH, 23 ANHEA T & B AF

GWINS %1 FPGA 7= i St R U Zhiit B 5 GWIN(R) R FIHS A
X 5 :

e MODE 1§y “100” I, fUJEiLEHEEM 2™ Wik Flash B3, 4 2" Flash
FiC B, 281k 150 Ak Flash Ji3h;

e MODE i} “110” W}, #sfHLseik# NS Flash J53), 244M5E Flash
FiC B, 281k 150 R Flash JH 3.

GWINS %1 FPGA 7= i UA shlic B 45 - A4S 14 5 GWIN(R)-6 Al
GWIN(R)-9 #[E], {H GWINS %741 FPGA /=i 2 A~k Flash FE#E 551
HEEIEAE 1 /> bitstream U1

XU B e EAR AR an ] 5-9 R
&l 5-9 X shit E A RAER

( start )

<
A
( end )

e LN MODE {4 “100” B XURZhfc & I A2 K . MODE B N “110” i FPGA
LA IEFE AN Flash J5 30 .

e GWINS %71 FPGA Witk | 2 4> Flash #itk, T A 110 FFHIFIHERE, BUEUEH
MODE 1 “100” KX s B .
T GWIN(R)-6. GWIN(R)-9 #1 GWINS Z4177 5, ToEi &mb A=t

FIXUS AL E, FPGA Y30 Hr 4 WL B 24

o DUULIEFMIAAMEIAZE 2N 3 U 3 IRIIRIBUE LS 7y — iRt TR EL
W E Flash 193 30 A BEJT IR T 0 bk

e MODE 5% “110” i, MAIMH Flash J& sl 3 k2T LUEFEAF 1)
JRBHNE, R B AE R E UG IE T SR AT SN R, AN 3
URHC B 2 ARG #e £ AN L Flash J5 3]

o XiF GWINS RSk, R BLSCRFRSIRMUE 2 R E 5 2k AE, A
IR B SR ShIE .
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5.7CPU it &%=,

E
SPI Flash A ai#ihkIC 12 A2 63k, A7 o] B 12 ADDR[23:12] 1)k =% [H] .

GWIN(R)-2 1 GW1IN(R)-4 #&14 H A A SR &4 B Zh XS S &
SO PR T IR A I XUR S E TR, A RS HTF
W (HFEsE-5 4 GWIN-4 2/ DUAL BOOT F# 77 %),

5.7 CPU I E&R

CPU it BT, HostiEid 8-bit £ 58 HIE#E M4 0 = =2k 3k
FPGA 7= il 4THC B, CPU it B & N 5-5 s
% 5-5 CPU B BB I

B IAA TR /O 27 B

RECONFIG_N !, AL K HL TRkl JH 3 GowinCONFIG it &

f
BT S L B R
READY Vo e L

T Bl SE R R L B

DONE Vo 16 FB P e R T i P

I, AERSS L

MODE[2:0] fic B LIRS, READY THRAE

SCLK | NI

I, W59 | mHF: CPU #EH L

CLKROLDN 1w R4 CPU B

L5 fE
0: 5
1: i

WE_N |

HHE NS H G . CPU RS B AU AR i N

D[7:0] Vo B, T G o T B At A AT 50

CPU Bt B A A i & e = B &l 5-10 o
5-10 CPU B B A EZEREE

Host FPGA
CLK SCLK

Y

DATA

A

D[7:0]

\ 4

78
WE_N

Y

WE_N

CTRL

CLK_HOLDN

Y

YE!
IERN CPU BB /N RS E, MODE EHE N “1117, HAdE v & W EEiE &%
5-1,

5.8 SERIAL fig EE3\

UG290-1.03

SERIAL it & #5X, Host ifiid B AT8: O & =2 54K FPGA F= 3T
B . SERIAL it 802 M S A E RO B . SERIAL At & X
HEeK LR EE S5 N FPGA, ik FPGA 284 [l dE, K, SERIAL

30(34)




5 Bt B AR A4 5.8SERIAL it B #i s,
1 B A X TC 1 ID CODE 1 USER CODE DL A2 R4S 2917 #8445 B, SERIAL
Hic B A = B I g L anER 5-6 Fiis.

% 5-6 SERIAL Fe B HAE & X
B4R /O 28 i B
RECONFIG_N 'ﬁ'j‘] RLRERS K H Sk J53) GowinCONFIG it &
S AT PO S T AR B
READY Vo EHP: 481 5 P AT R
- /o L T e A R B
MR SR 58 g R e B 2 P i B 2 I
MODE[2:0] WAL i, READY IHIRAE
SCLK | BN A
DIN 'ﬁw RLRERS LN Ei
DOUT o) Wi EdE, KT FPGA 208k SERIAL Fit & Ak 2
SERIAL At & A E R~ = B 5-11 Fis.
& 5-11 SERIAL B B R ER R ER
Host FPGA
CLK » SCLK
DOUT > DIN
!
KA SERIAL FL B /N AR %K, MODE BN “101” , HAhRE e& HEEiEss
5-1.
UG290-1.03 31(34)




6SPI Flash &4

6SPI Flash 1%+

m o 3R FPGA 77 5 SC BRI 4138 SPI Flash #8441 4E 48 4 1Nk 6-1 fir
TN, T3 WL Mxic 1 Winbond (172 554 2k
% 6-1 SPI Flash #1/E#54

BAE a4
bulk_erase C7
page_program 02
read 03
fast_read 0B
write_enable 06
write_disable 04
!

Fz Y- 3 FPGA SCHET Flash 548 4 U1 2 /0 —Fii2 03 8¢ 0B, M EP AR A= T
30MHz I 16 F @ 6 4 S B RE T 30MHz i, A PuE e 4, o 24
FASTRD_N & HIHifK, BEPSIZ A6 T 80MHz.

UG290-1.03 32(34)




7 LSRR

7ﬂ%ﬁi-’!ﬁﬁé{’ﬁ

B FAREAE 2 ITAG BLBE BT R, FEE 0 N KEEMEE: Kit
F- 454 BSDL SCAFHET 24 0F IR A 468 3 E4AH X FPGA B8 _E 4134
Flash #4742 BR A1 54
S AR R
1. K FPGA JT A BGER ] PC I L H;
2. 17 Gowin gmfEE 4 O 2 19 1F
3. 7f Operation T /7 A7 #5446 Flash 1, 3F1E A% () bscan 4k,
nE 7-1 For.

UG290-1.03 33(34)




7 AR

B 7-1 A F R R E

&y Prograrmmer - Untitled® = | B =
File Edit View Design Tools Help
T = = — — = = Y m -
bl a2t | Op
lEnahlel Family 1 Device 1 Operation 1 File l Checksum l L
F] GW2AR GW2AR-18  exFlash Erase Program in bscan  D:fsoftware/Gowin/1.7.2beta/work/ledwate... Ox779E 0
i ™y
Ay Device Configuration m
Dewice Operation
hecess Made: External Flash Mode ']
Operation: exFlazh Erasze, Frogram in bzcan 'J
exFlash Erase, Frogram
Erasze and program the extermal SFexFlash Program
Make sure the confiz frequency ir exFlash Erase _
- exFlash Eraze, Frogram in bscan
exFlash Frogram in bzcan
Programming Optiens exFlash Eracze in bscan
Programming File: T.Zbeta/work/ledwater/impl/pra/ledwater. fz E]
< . »
External Flash Options
x
Quiput | Hinbond H2SQE4 -] g
Start Addrss: 000000000
[ ok ][ Comcel |
—
Output Error Warning | Infa |

N R AR HBe0 FPGA 45 Flash #EATHAE, TEIENTA B Flash 5(
SRAM #HATHEACE . WA RMIEIERIZINE Flash B A 2550 FPGA
MODE {H )% &, {HiA LT MSPI #:1F h 4ifE 48 Flash (1) 5%, A5
TR I G P2 T P 0

UG290-1.03 34(34)




GOWINSE

EREB TR KX




	免责声明
	版本信息
	目录
	图目录
	表目录
	1 关于本手册
	1.1 手册内容
	1.2 适用产品
	1.3 相关文档
	1.4 术语、缩略语
	1.5 技术支持与反馈

	2 名词解释
	3 配置管脚介绍
	3.1 配置管脚列表及复用选项
	3.1.1 配置管脚列表
	3.1.2 配置管脚复用

	3.2 配置管脚功能及应用

	4 比特流文件
	4.1 配置数据加密
	4.2 配置文件大小
	4.3 配置选项设置

	5 配置模式介绍
	5.1 配置须知
	5.2 JTAG配置
	5.3 自启动配置
	5.4 SSPI配置模式
	5.5 MSPI配置模式
	5.6 双启动配置
	5.7 CPU配置模式
	5.8 SERIAL配置模式

	6 SPI Flash选择
	7 边界扫描操作

